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 This document contains information how to build a clock from basic building 
modules and using a 3D printer to create the case. This clock has several 
functions, it is meant as a 'kitchen alarm' but includes also a stopwatch and 
a normal alarm time. The software is included, to be changed to your liking. 
The user control uses a single rotary/push button. The display is a large dot 
matrix of four 8x8 pixel modules. 
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1 The setup / used items 
 
This chapter lists the different items required to build the clock.  
 

1.1 Schematic 

 

 
 
 
The hardware setup is simple. The microcontroller acts on a 1Hz pulse from the RTC, this is the system heartbeat. 
The Rotary/Switch and LDC form the user interface for input and output. An audio output is implemented by a 
standard Class D amplifier and a small speaker. The system is powered by a single battery which is mounted on a 
battery shield which converts the battery voltage to a stable 3.3V and 5.0V supply. This shield contains a charge 
circuit where the battery is charged from a micro USB input. The only glue components is an RC to debounce the 
switch function of the rotary knob. 
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1.2 The HW boards and electrical components 

 
The list of used components: 
 

Item Description Picture 

CPU A-Star 328PB Micro 3.3V 8MHz  
Pololu 

 
LCD MAX7219 FC-16 64x8 Dot Matrix Display 

 
RTC DS1307 / 24C32 - RTC / EEPROM module 

Battery CR2032 

 
AMP PAM8302 2.5W Class D amplifier module 

Adafruit 

 
Speaker Thin plastic speaker 8 ohm, 0.25W, 39mm, ADA-1891 

Adafruit 

 
18650 18650 battery shield 

18650 battery 

 
Rotary Rotary encoder (3 pins) + push switch (2 pins) 

Debounce RC: C = 0.1 µF, R = 10 Ω 

 
Switch S1 Toggle switch 2-p on/off with solder lugs 

 

 
 
Indication of costs: Some of the boards can be ordered in a set of 5 or 10 pieces. Using different suppliers the cost is 
around 25 Euros to 30 Euros for the above list of items. 
 
 
 

1.3 The mechanical components 

 

Item Description 

Magnet 4x magnet 5x5x5 [mm]  Optional 

Screw 8x M3x5 black oxide steel philips cross recessed pan head self-tapping screw 

Screw 7x M2x8 stainless steel flat head philips self-tapping (Case) 

Bolt + Nut M3 x 23 (to mount the RTC board) 

Case bottom 3d printed, file: Bottom_plate_v4.stl 

Case front 3d printed, file: Front_v34.stl 

Case cover 3d printed, file: Cover_v28.stl 

Case knob 3d printed, file: Rotary_knob_v3.stl 

Screen Plexiglass plate: 132 x 35.2 x 2 [mm] 
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2 Where to find what 
 
 
Clock_v10.doc  This document 
Clock_timer_schematic.drawio Schematic 
  
 Clock_Case_STL_files 3D print files for the 4 case items 
  Bottom_plate_v4.stl  
  Cover_v28.stl 
  Front_v34.stl 
  Rotary_knob_v3.stl 
 
 Operating_Manual Manual 
  Operating_Manual.jpg 
 
 Software 
  Clock_v10 Directory containing the sketch 
   project_libraries Directory with used libraries as reference only 
   Clock_v10.ino Arduino IDE project file 
   defs.h Definitions of pins, modes, etc. 
   font3x5.h Definition of font 
   font4x7digits.h Definition of font of numbers 0 to 9 
   license.txt MIT license (free usage) 
   pitches.h Definition of sounds 
   Rotary_wemos.cpp + .h Rotary class 
   Time.cpp + .h Time_Interface class 
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3 Build instructions for the hardware 
 
This is a guideline for building the hardware, with the intention to highlight items not seen in the schematic. 
 

3.1 Step 1: The case 

Print the four parts of the case or order them by a print service. 
The STL files are provided, slice them with your preferred software to match your 3D printer. 
I have used a Creality CR10S printer and Simplify 3D as slicer software. 
 
All items are printed with a 0.4mm nozzle, using 0.2mm layer height, the basic settings are shown here: 
 

   
 
 
 
 
Cover: 
The cover is intended to be printed in the orientation shown in the 
picture. See the upper black arrow, that piece should be at the top side, 
it gradually widens to hold the mounting screws. This eliminates the 
need for support material at this location. 
 
The cover needs support material for the USB cable connector, see the 
lower black arrow in the picture.  
Resulting support material when sliced: 

 
 

 
Bottom plate: 
Orientation as shown. 
No support material needed. 
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Front plate: 
Orientation as shown. 
No support material needed. 

 
 

Rotary knob: 
Orientation as shown. 
No support material needed. 

 
 
 

3.2 Step 2: Schematic, mount electrical components 

 
This step describes in detail how to mount and connect the electronics. You might as well use the schematics and 
quicky check the pictures about the intention, basically these three items are not seen in the schematics: 
1) How to mount the programming connector on the CPU board 
2) The removal of the LCD connector 
3) The replacement of the crystal on the RTC board 

 
Prepare the CPU board 
Solder a five pin straight header on top of the solder islands as shown in 
the picture. The purpose is to keep the bottom side of this PCB as flat 
as possible, therefor this soldering method is used. The two most upper 
terminals are GND. The upper most terminal is not connected. 
 

 

Prepare the LCD board 
If your LDB board contains the connector as shown in the picture on the 
right most side, then remove this connector. 
If you do not have a desolder tool, just cut the connector to separate 
each pin and desolder the individual pins. 

 
 

Where the connector is removed, the “IN” side of the PCB, wires are 
connected as shown in the picture.  
 
Use two red wires for Vcc (5V), and two black wires for GND. 
 
For the Din, CS and Clk pin a thin copper wire is used, which is isolated 
by a thin coating. This is the same sort of wire as what is used in 
transformer coils. Heat the end of the wire to burn away the coating. 
These thin wires are extremely handy in all kind of applications. 
 
Make sure the bottom of the PCB remains flat, if solder is found on the 
other side if the pins, then cut it off with a knife. 

 
 



 
 

Arduino Project Info   Copyright © 2022, Henk Beekhof  All rights reserved. Page: 8 

Mount the LDC as shown in the picture. 
 
Mount the cubic magnets in the four square holes of the bottom case 
before you replace the two 8x8 LCD modules in the left side and right 
side of the LCD board. 
 
Note: Let the magnets fall on a metal item, detach them and use that 
orientation to mount them in the bottom case. Use something sturdy like 
a screw driver to push them to the bottom of the hole. 

 
 

Connect the LCD signal wires (Din, DS, Clk) to the CPU board as 
indicated by the schematic diagram. 
Example: CS is connected to PB2. See chapter 8.1 and search for PB2. 
Place the CPU in the correct orientation as shown in the picture, later, 
when all connections are done the CPU pcb will be pushed into the 
bottom plate in the ‘island’ shown in the picture just above the PCB.  

 
 

 

Connect wires to the audio amplifier board 
Thin copper wires for A+ and SD. 
Thin copper wire to connect A- with GND. 
Normal wires for the speaker. 
Strip the GND wire from the LCD and connect it to GND, leave a black 
wire as shown in the diagram to connect to the rotary. 
Strip the Vcc wire from the LCD and connect it to Vcc. The diagram 
shows that the red wire is extended, this is not needed, this should be 
an ‘end point’, because the other Vcc from the LCD will be connected to 
the power switch to power both the LCD and Audio board with 5V. 
 
Push the audio board in its placeholder, orientation as shown in the 
picture. 

 
 

 
 

Mount the power switch and rotary in the front cover. 
 
The ‘bottom’ side of the rotary contains the two switch terminals. 

The right terminal is later connected to GND. First mount the 0.1F 
capacitor and a thin wire to this terminal. Connect the thin wire (GND) to 
the middle pin of the three rotary terminals.  
 

The other side of the capacitor is connected to the 10 resistor and a 
thin wire which actually is the ‘switch’ signal. Connect this wire to the 
CPU board. The other side of the resistor is connected to the left 
terminal of the switch. 
 
Connect two thin wires to the upper left and right terminal of the rotary. 
These are the rotary signals. Connect these to the CPU board. 
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Power wires 
Connect the black (GND) wire from the audio board to the bottom right 
pin of the rotary (where the capacitor is connected to). 
 
From the 6 pins the upper 4 are used, left is for 3V3 and right is for 5V. 
 
Connect the red (5V) wire from the LCD to the upper right pin of the 
power switch. This pin powers the LCD and amplifier. 
  
Connect a red wire to the middle right pin, this is the 5V source from the 
battery, guide the wire to the battery location. Do the same for the 3V3 
source with a green wire. Together with the black wire from the LCD, 
these wires are found in the picture beneath the nippers. 
 
Connect a green wire to the upper left pin, this is later used to connect 
to the Vcc of the RTC and CPU. 
 

 

The RTC board 
This board is inaccurate, I measured an error between 6 and 12 
seconds per 24 hours. You find articles on the internet which state this 
is due to a copy of the RTC chip. But after replacing, no difference was 
seen. The DS1307 manual specifies a crystal with CL (Load 
Capacitance) of 12.5pF. I tested with crystals with different load specs, 
and it turned out that this influenced the accuracy heavily. My 
conclusion is that the boards which I got do not have a crystal with the 
required load capacitance. Advice: Replace the crystal with a crystal 
where you know for sure that the internal load capacitance is 12.5pF. 
 

 

Copied from the DS1307 Datasheet: 

 
 
The RTC board will be mounted with an M3 bolt through the hole of the 
left LDC ‘holder’ shown in the picture. 
 
First connect thin wires to the SCL, SDA and SQ pins. 
 
Connect the green wire from the switch to Vcc and let it continue. 
Connect the black wire from the LCD to the GND and let it continue. 
 
Bring these 5 wires to the battery/CPU side. 
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Mount the RTC board as shown in the picture. 
Mount the backup battery CR2032. 
 

 
 

The battery board contains a large USB connector and a small USB 
connector. Remove the large USB connector.  
Easiest way to destructively demount the connector: You can displace it 
by heating the mechanical soldered connection one by one to lift it up, 
then cut through these two pins. Now you can move the connector back 
and forth until the USB pins at the back of the connector break. 

 
 

The micro-USB connector has two mechanical mounts. This makes this 
component the critical part of this board. I would recommend suppliers 
to use connectors with 4 mechanical mounts. To make it more robust I 
glue this connector. Make sure no glue gets into the connector. 

 
The picture shows the orientation of the battery board. Mount for each 
supply (3V3 and 5V) a two pin header.  
 
Connect the green 3V3 wire to the 3V3 supply. 
Connect the red 5V wire to the 5V supply. 
Connect the black wire from the RTC board and the black wire from the 
CPU board with GND. 

 
 

Connect the speaker. 
Make sure it fits mechanically in the ‘hole’ of the case. 
Mount the speaker in the case and use some glue to keep it there. 
 
Everything is now nicely connected, ready for the next step:  
Program and testing 
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3.3 Step 3: Programming and testing 

 
For programming a Pololu board is used: 
Pololu USB AVR Programmer v1.2 
Reference: https://www.pololu.com/product/3172 
 
 
I’ve soldered a ’90 degree connector’ to connect the programming board 
with the CPU. See second picture for detail, upper pin is not connected. 
 
See chapter 4 to install the Arduino IDE and which settings to use to 
program this particular CPU board. 
 
Power the board by the main switch. 
Load the sketch provided, and program it in the board. 
Result: The clock should be counting up. 
 
Test the rotary knob, and audio: Press it once, if you turn it right the 
alarm time should increase. Set it to a low value and press the rotary 
again. The time should count down and an alarm should be heard when 
the time reaches 00:00:00.  

 
 

 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

https://www.pololu.com/product/3172
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4 Arduino IDE 

4.1 Installation 

 
Via the link below you find information how to install the Arduino IDE on your system: 
https://docs.arduino.cc/software/ide-v2/tutorials/getting-started/ide-v2-downloading-and-installing 
 
This application was developed using version: 1.8.5. Later installed version: 2.0.3 
Note: You might also consider to use Microsoft Visual Studio, this is for free, and is more advanced than the Arduino 
IDE related to ease of use, debugging features, this is a professional environment. 
 

4.2 Location of the code + way of working 

By default, the Arduino IDE stores the projects in c:\Documents\Arduino\ 
In File -> Preferences you can change this default path. 
 
The (to be) developed code is not checked-in and checked-out by using a revision system, for now the way of 
working is to save a new project on a major new step in the development process. The Arduino IDE makes this very 
easy, since a 'Save as' saves all files of the project into the new project folder. 
Method: Use 'Save as', move up to the projects folder, define a new name, which is the new project folder. 
 
Differences in Arduino code related to other systems: 
A project has two procedures, called setup() and loop(), after a powering on the Arduino board, first the setup() is 
executed once, then the loop() is started, which runs repeatedly. 
 

4.3 Setup Board and Port to compile and upload software 

 
Step 1: Define the target board 
In Arduino IDE: Tools -> Board: -> Select the applicable board. 
Note: This is an IDE setting, thus not related to the project file (.ino), which is strange....and sort of inconvenient if 
you do parallel developments using different boards. 
 

 
 
 
 
Step 2: Define the serial port 
Start the Device Manager and open the section 'Ports' to find out which port is used. 
Search for the item "Pololu USB AVR Programmer v2.1 TTL Serial Port (COMx)" 

https://docs.arduino.cc/software/ide-v2/tutorials/getting-started/ide-v2-downloading-and-installing
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In Arduino IDE: Tools -> Port: Select the correct COM port found in the Device Manager, (COM5) 
 
 
Step 3: Set the board version 
In Arduino IDE: Tools -> Version: Select the 3.3V, 8MHz option 
 

 
 
 
Step 4: Define the programmer 
In Arduino IDE: Tools -> Programmer -> Select "STK500 for Pololu A-Start328PB" 
 

 
 
 
Step 5: Optional: Change settings to verbose output 
In Arduino IDE: File -> Preferences 

 
 
 
 
Step 6: Optional: Test if the settings are correct by compiling and uploading a simple sketch 
If you want to test these settings then write a simple program. For instance: 
void setup() { 

  Serial.begin(9600); 

} 

void loop() { 

  while (1) { 

      Serial.println("Ok"); 

  } 

} 

 
Press the Upload button which also compiles the code if not yet done: 
Then open the Serial Monitor, that should show lots of 'OK's. Tools -> Serial Monitor   or   keys: Ctrl + Shift + m. 
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5 The software 
 

5.1 Library dependencies 

 
The software depends on three libraries: 
- MD_MAX72xx 
- AT24CX 
- RTCLib 
 
In the source code folder the libraries are included in folder "project_libraries". 
These are for reference only, these files are not included in the software from this location. 
 
These three folders should also be found in the library folder: C:\Users\User\Documents\Arduino\libraries 
They are used from that location. 
 
It seems not very straight forward within the Arduino environment to use libraries from 'your own' specified location. 
This makes it hard to distribute code or make a backup copy of your code which includes all dependencies. 
It is the way it is, thus please either sort out from where to install these libraries or just copy the directories from the 
"project_libraries" into the Arduino library folder. 
 

5.2 Operation 

The basic operation is simple. The RTC is programmed to generate a 1Hz pulse on the SQ pin. This pin is 
connected to an interrupt input of the CPU. On each 1Hz interrupt the 'interrupt_1Hz_flag' is set. 
The loop() function checks this flag, when set it updates the time and resets the flag. The clock has a 'dark mode' 
which adds some code to this part. 
 
Then the loop() function checks if the rotary button is pushed, in 'dark mode' this turns on the display. Further it 
checks if the button is pressed once or twice. If it is pressed once, then the kitchen clock mode is entered. If it is 
pressed twice, the menu is entered. 
 
For more details: Check the comments in the code. 
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6 Operating manual 
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7 Lessons learned 
 
Case: 
When designing the bottom part of the case, I did not pay attention to default lengths of M3 bolts. Later I could not 
find a standard length bolt to mount the RTC. Solution: saw a bolt to the correct length of 23 [mm]. 
 
The triangular pass-through for wires in the LDC stand is nice to guide the wires, but is very inconvenient if you 
would want to replace the bottom part with another bottom part. This pass-through should have an opening to be 
able to get the wires in and out. 
 
Hardware: 
1) RTC board inaccuracy: root cause: Xtal with wrong load capacitance used, maybe only selected on price. 
2) Battery board: Mechanical weak design related to micro USB switch. 
 
Software: 
1) RTClib does not take the Clock Halt bit into account which is the root cause of system failure. 
2) A dedicated library for the used EEPROM did not work on reading data. Used another library. 
 
Arduino IDE: 
The Arduino IDE is kind of strange in multiple ways when one is used to professional IDEs. Some examples: 
Library management is fixed, very strict, not user friendly. 
File management is strange (Why must the .ino file have the same name as the directory it lives in) 
Debugging capabilities, as well as editing capabilities, as well as user configuration, are very limited. 
Not able to break (easily) a 'program' action which is sent to a wrong COM port, or which you want to stop. 
Each 'program' action first compiles (the already compiled) files, not found how to turn this off. 
 
Since the Arduino community seems to use this IDE, I've used it for this project. 
For other projects I use Microsoft Visual Studio. 
Short video found on youtube to get up and running with VS: https://www.youtube.com/watch?v=asYqoqbRE_I 
 
Software for developing 3D parts: 
The STL files for the case and rotary knob are developed using Autodesk Fusion 360. This tool is free of charge 
when used for non-commercial projects. This tool is extremely flexible, yet easy to use. It was great fun to find out 
how to draw the 3D parts. I recommend this tool. 
 
Software for drawings: 
The schematic is drawn in draw.io. This is a very flexible drawing tool. I recommend this tool. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

https://www.youtube.com/watch?v=asYqoqbRE_I
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8 Detailed info - HW boards 

8.1 A-Star 328PB Micro and USB AVR Programmer v2.1 

 

    
 
Reference:  https://www.pololu.com/docs/0J74/all (CPU) 
  https://www.pololu.com/product/3172 (Programmer) 
 
 

 
 
 
 
Programming settings in Arduino IDE (Menu: "Tools"): 
- The board should be set to "Pololu A-Star 328PB" 
- The version should be set correctly depending on the used board 
- The port should be set to the port 'n' connected to "....Programming Port (COM n)" 
- The programmer should be set to "STK500 for Pololu A-Star 328PB" 
- The programming board does not supply the CPU board, thus provide a power supply to the CPU board 
 
Use the standard windows Device Manager to find the used "Programming Port" COM port 

 
 
Screenshot of settings: 

https://www.pololu.com/docs/0J74/all
https://www.pololu.com/product/3172
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Schematic CPU board: (Including table D3 color led indicates the board type related to supply and frequency) 
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8.2 FC16 Matrix LCD (MAX7219) 

 

 
 

Module:  FC16 
IC:   MAX7219 
LCD:  1088AS 
8x8LED 
Vcc:   5V 
Control:  SPI 

 
 
Columns and Rows 
Asuming the input cable is positioned at the right side, the the following info about columns and rows is valid: 
In above diagram the X axis represents Column, starting at 0 at the right side. 
Columns: G=0, F=1, DP=7, and the next chained segment G=8, F=9, etc. 
Rows: D0 to D7 represent a row. D0 is the LSB of the data. 
The triangle of dots in the bottom left corner, the dot in ‘coordinate’ {DP,D4} equals {Col=7,Row=4} 
 
Fonts 
Byte 0:  The number of column bytes (N) that form this character, equals zero if the character is undefined 
Byte 1..N: One byte for each column of the character. Thus it represents the content of a column. The LSB of this 

byte corresponds to row 7, the MSB corresponds to row 0. 
 
Example: Character ‘&’, represented in 5 bytes: 

5, 0x36, 0x49, 0x56, 0x20, 0x50,  // 38 - '&' 
Column 9 8 7 6 5 4 … 0 

Font Byte 1 2 3 4 5    

Row 0, bit 7         
Row 1, bit 6         
Row 2, bit 5         
Row 3, bit 4         
Row 4, bit 3         
Row 5, bit 2         
Row 6, bit 1         
Row 7, bit 0         
Font value [hex] 36 49 56 20 50    

 
 
Library MD_MAX72xx 
 
Font definition 
The font is located in file: MD_MAX72xx_font.cpp 
This is a variable sized font, the first byte of a character specifies the width 
 
MD_MAX72XX::fontType_t PROGMEM _sysfont_var[] = 

{ 

  'F', 1, 0, 255, 8, 

  0,  // 0 - 'Empty Cell' 

  5, 0x3e, 0x5b, 0x4f, 0x5b, 0x3e,  // 1 - 'Sad Smiley' 

  5, 0x3e, 0x6b, 0x4f, 0x6b, 0x3e,  // 2 - 'Happy Smiley' 

  5, 0x1c, 0x3e, 0x7c, 0x3e, 0x1c,  // 3 - 'Heart' 

 
See library documentation on the internet or from the downloaded library: 
file:///C:\Users\User\Documents\Arduino\libraries\MD_MAX72XX-master\docs\index.html 
Examples to set a point or a byte on a row or column: 
setPoint(Row, Col, Value); 

setRow(RowNr, Value); 

setColumn(ColumnNr, Value); 

 
How to position a character 
setFont(fontType_t* f); 
 
 
 

../../Users/User/Documents/Arduino/libraries/MD_MAX72XX-master/docs/index.html
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Other definition of fonts: Using a fixed size 
For the width of characters a fixed size is used. Setting a pointer to a character is easy, however based on the font 
definition the order of characters needs to be handled. 
 

This specifies a font named myfont, containing 80 characters, where each characters is 5 bytes wide. 

unsigned const char PROGMEM myfont[80][5] = { 
  {0, 0, 0, 0, 0},     // Space 
  {0x3f, 0x48, 0x48, 0x48, 0x3f},   // A 
  {0x7f, 0x49, 0x49, 0x49, 0x36},  // B 
 
This requires mapping of ascii character value to a position in the font table, example: 
if (c >= 'A' && c <= 'Z' ) { 

    c &= 0x1F;     // A-Z maps to 1-26 

} else if (c == ' ') { 

    c = 0;     // space is located on position 0 

} etc. etc. 

 

This is one standard mapping routine, the resulting value for c is used in next fetch action: 
for (char col = 0; col < 5; col++) { 

  fontByte = pgm_read_byte_near(&myfont[c][col]); 

 
Parola library 
See library documentation on the internet or from the downloaded library: 
file:///C:/Users/User/Documents/Arduino/libraries/MD_Parola-master/docs/index.html 
 
Definition and instantiation 
#include <MD_Parola.h> 

#include <MD_MAX72xx.h> 

#include <SPI.h> 

 

// Define the matrix LCD type and size 

#define HARDWARE_TYPE MD_MAX72XX::FC16_HW 

#define MAX_DEVICES 4 

#define CLK_PIN   D5   

#define DATA_PIN  D7   

#define CS_PIN    D8   

 

// Define the display 

MD_Parola P = MD_Parola(HARDWARE_TYPE, CS_PIN, MAX_DEVICES); 

char curMessage[64]; 

void setup() { 

  P.begin(); 

  P.displayClear(); 

  P.print("Text"); 

  Delay(5000); 

  P.displaySuspend(false); 

  strcpy(curMessage,"This is text"); 

  P.displayScroll(curMessage, PA_LEFT, PA_SCROLL_LEFT, 25); 

} 

void loop() { 

  if (P.displayAnimate()) {  

    P.displayReset(); 

  } 

} 

 

Display a character at a specific location 
This is not possible with this library. It handles strings, and you can devide the display in several zones, however a 
zone boundary is a module boundary. It is not possible to create a zone from a certain column to another column. 
This makes the usage of zones limited and for instance not usable when you want to update specific characters, 
such as in a counter or time or date. 
 
Writing the whole display over and over again has on the other side a benefit: Disturbance could set unwanted 
pixels, they stay when that part of the display is not updated. 
 
Thus when individual character positioning is needed, one could consider to use the MD_MAX72xx library without 
the MD_Parola library.  
 
 

../../Users/User/Documents/Arduino/libraries/MD_Parola-master/docs/index.html
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8.3 RTC/EPROM Module DS1307/24C32 

 
  

  

VCC = 3.3V to 5V 
DS = Temp sensor  
SQ = Square Wave 

 
 

RTC: 
Chip: DS1307 
 
Note: These boards might run too fast. If so: Change X1 with a crystal with a load capacitance of 12.5pF.  
Note: The RTClib mentioned below does not take into account that the Clock Halt (CH) bit could be enabled due to 

whatever issue. The problem is that this bit is only reset when all supplies, thus also the backup battery 
CR2032, are removed. If you turn on programmatically the SQ pin, then the library does not check this CH bit. 
Thus when the clock is disabled, the SQ pin does not output a clock. In my opinion this is incorrect. The library 
should turn on the clock if you program a frequency on the SQ pin. Since this bug keeps a user puzzled with a 
dead system, I added code in the application to force the CH pin to make sure the oscillator is running. 
See Time.cpp function init() 

 
The RTC is used through the RTClib: 
https://adafruit.github.io/RTClib/html/class_r_t_c___d_s1307.html 
 
For convenience I have wrapped this library in a Time_Interface class. This is extremely handy when the underlying 
hardware changes, actually this class was used on other hardware first. 
 
 

EEPROM 
Chip:  24C32, 32K := 4096 x 8 = 4K bytes 
Endurance: 1 million write cycles 
Write: 32 Byte page write mode (partial page writes allowed) 
I2C Address EPROM: 0x50 
 
eeprom library: https://github.com/cyberp/AT24Cx 
 
 

8.4 Rotary encoder + switch 

 

        
 

https://adafruit.github.io/RTClib/html/class_r_t_c___d_s1307.html
https://github.com/cyberp/AT24Cx
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